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1. Introduction

Purpose

Telehealth offers incredible potential to transform the healthcare delivery system by overcoming
geographical distance, enhancing access to care and building efficiencies.

One of the challenges is the degree and variation in telehealth processes around usage and
documentation. Bendigo Health identified a need to develop a Telehealth Resource Package as a
simple, practical tool which could meet the needs of clinicians.

The resource package highlights two telehealth technology platforms used within Bendigo Health,
Health Direct and Cisco CMS. Health Direct is a video call management platform which is web-based
that lets healthcare providers offer video call option as part of their day to day operations. Whilst
the Cisco CMS brings premises-based video, audio and web communication together to meet the
collaboration needs of the modern workplace. It works with third-party devices and provides
intuitive user experiences. Both telehealth technology platforms have their advantages. Firstly,
Health Direct is better suited to stream to a patient home and does have the option of having
multiple consumers in the one room (virtual waiting room). Whereas the Cisco CMS works better for
clinician to clinician consultations (i.e. hospital to hospital).

The Telehealth Resource Package was created to provide a generic high level resource that includes
a toolkit of templates and checklists which can be customised to meet local demand. Clinicians
should choose a platform that they believe will best suit the needs of the provider and the
consumer.

Bendigo Health has also made available further resources that can be found on the intranet page.
For further information, please click here
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2. How to use Health Direct (Telehealth)

Overview

Telehealth is a normal medical consultation between a patient and a medical specialist using video
conferencing software and an audio and visual link over the internet without having to attend
Bendigo Health in person. As stated, Health Direct works best with direct where a telehealth
consultation can be streamed directly into the patient home.

How does Health Direct Work?

Using a computer, iPad, smart phone or other related device, you need to connect in using Health
Direct to see the patient. You would require a good internet connection, a private, well lit area and a
web camera, speakers and a microphone.

How to logon to Health Direct?

Users will first need to request a logon from Bendigo Health’s Coordinator Multimedia. Once a logon

account has been triggered by ICT, you register with your BH email address, followed by the creation
of a password. You will need to remember the password to make a video call.

Sign in to Healthdirect Australia Video Call

shaker@bendigohealth.org.au

Forgot your password? Reset it now.

Heep me signed in on this device

m Go to the Resource Centre

Telehealth: Resource Package
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This will take you to a ‘dashboard’ screen where you can see the clinical area/s that have been
assigned against your profile.

healthdirect

Video Call

Dashboard Waiting Areas  Meeting Rooms ~ Admin ~ Settings Help ~ Search _

Video Consulting Dashboard

Welcome
Joanne Flemin
0 Calls to Waiting Areas Last updated at: 01:5528 pm = 9
Palliative Care nwalt\ng n being attended n mins longest wait n idle calls Sign out
) 8] Test call
You have not made any calls yet You don't have any accessible meeting rooms yet. ! = esl ca
4 Create a Mesting Room
1 Organisational Unit -
0 Meeting Room
0 Group
1 Waiting Area
£ View Al

Once the patient has arrived in the ‘waiting area’, please join the call, introduce yourself and check
patient details. Same process as face-to-face. When your patient has logged in, the waiting area
labelled “0 waiting” will turn orange and say “1 waiting”. Double click on the orange “1 waiting”.

e Alist will appear of people waiting in the waiting room. Select a patient from the Waiting

Area.
Video Call

Dashboard Waiting Areas Meefing Rooms  Admin ~ Settings Help~ Search... o
Bendigo Health Send alerts t

. e Refresh ena_fuio_ Ea Welcome
People in Waiting Areas Last updated at 11:30:55 am [ RAAeRSRR Simon Baker  Gurent Gl
View (@) All Calls Calls | can join

Sign out

m ame o Galler Viaiing frea m Faricipans

Waiting 0 min 11:30 AM Simon Baker CDAMS Clinic 11:30 AM —a
@ 2 | Test call

e Then click on the “Join” button.
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healthdirect

Video Call
Dashboard Waiting Areas Meeting Rooms  Admin = Settings Help » Search... o

Bendigo Health Refresh Send alerts to
5 o m Welcome
People in Waiting Areas Last updated at: 11:39-14 am Simon Baker

View (@) All Calls Calls | can join
m Hame of Calier O m L

11:36 AM Simon Baker CDAMS Clinic 11:36 AM —
[ 5 | Test call

L simon Baker ‘. 0334547176 ¥| Video
«| Sound

Participants (1) w History (1) w Notify

Sign out

e The call screen opens. You can see the patient. Your image is a thumbnail at the bottom
right hand corner of the screen.

e Complete your three-point check with the patient and advise that they will be placed back in
the waiting room for the doctor to pick up.

e Move mouse into top right hand corner of screen, buttons will appear, choose ”-”
button, then red ”_” (middle button of three).

e  Waiting area appears with patient sitting as red - while awaiting for doctor.

e When doctor picks up call patient, idle will turn to green “ "

e Once the doctor finishes the call and hangs up, he/she will use Q Manager to inform the
administration staff of the outcome. At the end of the consultation the clinician will let the
patient and the administrator know that they will be discharged from the clinic or that they
require a follow up in x/12. An appointment letter, along with telehealth information will be
sent in the mail to the patient.

Volume controlled by function keys — F5 volume down; F6 volume up
The Mute button is F4

At end of telehealth session, be sure to:

e Bend surface pro mouse back to flat shape (this turns it off) and pack Surface Pro up into
case with adaptor and plugs;

e After the telehealth consult is completed (or at the end of the clinic);

e Please ensure that both CoW and Surface Pro are returned to storage and the CoW is
plugged in so that it can charge for the next clinic to use;

e Turn of the CoW and the mouse using switch underneath.

The Consultant will return the patient history to reception and a further follow up appointment can
then be made with the patient by phone or email on return to the office.
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Troubleshooting

Troubleshooting guides are available for providers and consumers, by visiting the Bendigo Health
telehealth webpage.

e Video Call Consumer Information Sheet (Health Direct)

e Video Call Troubleshooting Reference (Health Direct)

iPM - Booking a Patient for Telehealth through iPM, using the Health Direct Platform

Book patient in as you would normally. Either the GP or clinician will identify whether a telehealth
consult is a suitable option and will discuss this with the patient. Should the patient agree to the
appointment, the patient is booked into iPM book as per usual process. However, when asked if you
want to add in Dependent Resources, select “yes”, scroll down available resources to “Telehealth”
and add to the right side column, then select “OK” and continue as normal.

l B I el l_h.l e l F___ I
% \-:‘

Appointment Details | Clinic Worklnadl Referral Dependent Resources |Eoding| Outcome | Compensabl 4 I 'I

— Rezources —Alzo Seeing
I Axailable regources: Selected rezources:

fdd > | Telehealth

Allergy Testing
Pai Audialogy
Bone Dengity ﬂl
2B cT 18
CT Scan
I Cardiac CMYOF
Cardiac Tech 1 | | >
b1) Cardiac UPAC _I
E Elnzapirlel :I Add... | Bemove | :
268
o —Appaintment D etails — Comments

578 D ate: |21 0972017 General:
063
1 Time: |1313U

Clinic: |PCoMEs

Preparations:

Session;  |PCOMBS TPM Diet: | =]

EditF'atient...l ok | cancel |

When sending or emailing out the letter to the patient to confirm the appointment, choose the
appropriate telehealth letter on iPM, edit as required and print out a copy for the patient and for the
GP. Enclose with the patient letter a brochure and three PDF attachments -

e Video Call Consumer Information Sheet Bendigo Health
e Video Call Troubleshooting Reference
e Telehealth Brochure

These documents can be found on the Bendigo Health website:
www.bendigohealth.org.au/telehealth

Telehealth: Resource Package
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If emailing out the appointment letter, include the letter as well as the three attachments.
Billing - Medicare Billing Schedule (MBS)

MBS

Firstly, the patient must have a valid referral from a GP.

Bulkbill the telehealth appointments direct to Medicare. Patients who have a telehealth video
consultation with a specialist have the option to assign their right to a Medicare benefit to the

specialist through an email agreement (if no email we will post our hard copy).

At the time of the telehealth video consultation, tell the patient you wish to bulkbill Medicare for the
service and they will need to:

1. Agree to the service being bulkbilled;
2. Check their details in the email that will be sent to their nominated email address; and

3. Reply to the email, which will be considered a signature agreeing to assign the benefit.

Here is a copy of the template to use for the email consent:

(&%
Tl . ¥ = Untitled - Message [HTML) o B &

Message Insert Options Format Text Review & g

=- |2 ﬂ @] @ J@ ﬁ’ ¥ Follow Up - ._“%\

‘? High Importance

Helvetica + 11 = A A~

LJH

3 Cop

Paste . A === Address Check = Aftach Attach Signature Zoom
- fFormat Fainter LS e = = = Book Mames File THem~ - § LowImportance

Clipboard ] Basic Text 1 Mames Include Tags x| Zoom

To...

Bec..,

Subject:

» i

Dear Eirstname,

Medicare requires that we have consent from our patients for their Telehealth appointments. Can you please respond accordingly to this email:

Agreement: If you, the patient (or carer or guardian) agrees to the assignment of the Medicare benefit directly to the specialist (bulkbill), reply to this email including:

*x****The word “YES” in the body of the reply email; and*

*X**The patient's name.*

Details of Telehealth consuttation to be claimed with Medicare:|
Description of Services: New/Review Consultation

Patient Name: Firstname SURNAME DOB: DoB,

Date & time of appt: Date of appt at time of appt

Provider Name: Dr_ Palliative Care Consultant

Privacy Note: Your personal information is protected by law, including the Privacy Act 1988, and is collected by the Australian Government Department of Human Services for the
assessment and administration of payments and services. This information is required to process your application or claim. Your information may be used by the department or given to
other parties for the purposes of research, investigation or where you have agreed or it is required or authorised by law. You can get more information about the way in which the department
will manage your personal information, including our privacy policy or by requesting a copy from the department.
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When a reply is received, keep a copy of the email in electronic or hard copy format (as we need to
keep these for at least two years for audit purposes).

This process has been developed to comply with section 10 of the Electronic Transactions Act 1999,
which outlines the steps to be taken for an electronic signature to be recognised. It also meets the
legislative requirement of a signature being needed to assign a Medicare benefit.

Here is example template that could be used for post or faxed consent. If the patient does not have
an email address, then prefill and send this form to the patient either via hard copy, fax, to local
medical centre - whichever method suits.

Telehealth: Resource Package
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HEALTH

MEDICARE BILLING CONSENT FORM

PALLIATIVE CARE SPECIALIST CLINIC

B - S M F

Madicare raquiras T3l wa hava consan fam our patans for fhalr Talshasiin appainiments.

Can you piBase SQn IS fOOM  arer pour Telehealth ADDOIRIMEnT and MM W3 emal o
Imrpeesimbenoipnhesith.0rn.ay oF post i LMRPCCS. PO Box 126 Bandign 1552,

Agreement: ¥ you, he patam (o carar or guardian) agras 1o e assignmant of e Madicara banafl dractly 10
[MRPCCS (bl bill), phazsa sign tha farm balow.

Datals of Teishasiin consuitsian 10 be claemead wWith Madicars:

Drescription of Sarvices: Talshaaliin Naw/Review cansuiisiian

Patiant Hams: v [ cos: [ G

Crate & Time of Appt: G Ociabar 2017 31 9.30 am

Providar Hame: or [-=05t = 2= consutam

TOW PIENE NTNNIRIN 5 prRSCEd Oy 3w, NOUKGINg M2 FVaCy AT TG, and B 02012 0y N2 AUSTIEan
Govamnmean Daparimeant of Human Serdcas fr 12 3s52ssmant and administaton of paymants and sandces. This
Iirmatan |5 raquired 19 process your pEcaiion o clam. Your iTfanmatian may be usad by 118 depanman or ghvan
10 ofhar pariies for e PUTPISSs of resaanch, iMvesBgalion or wiana you have agresd or i ks regquired o autharis=d by
[aw. YU can g=i mars imrmatian aboul e way In which e danarimeant will manags your parsanal imonmatan,
Inchuding our pitvacy pallicy oF by raquasiing 3 ooy inam e danartmeant.

1, I 5.1nons= LuRACCS, Bandigo Hesm, 1o 52 3N account drachy to Madicars AUSTEEa T my
Talahaan appammen today.

Sagnad:

Further information can be found using the following link:
https://www.humanservices.gov.au/organisations/health-professionals/enablers/bulk-billing-
telehealth-video-consultation
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Creating an email message template

ogakrwbdE

In Microsoft Outlook, click on the Home tab, in the New group, click New E-Mail.
In the message window, enter the content that you want.

In the message window, click the File tab.

Click Save As.

In the Save As dialog box, in the Save as type list, click Outlook Template.

In the File Name box, type the name of your template, then click Save.

Send an email message based on a template

1.
2.
3.
4.
5.

6.

In Microsoft Outlook, click on the Home tab, in the New group, click New items, point to
More items, and then Choose Form.

In the Choose Form dialog box, in Look In, click User Templates in File System.

The default templates folder is opened. The folder location is
c:\users\username\appdata\roaming\microsoft\templates. If your template is saved in a
different folder, click Browse and then select the template.

Select template and then click Open.

Make any additions or revisions to the recipients in the To, CC or Bcc boxes. You can also
change the text in the Subject box and add contents to the message body.

Click Send.

Note: Changes made are not saved to the template. If you use the Save command, this creates a
draft of your message, but will not update the template. To update the template, follow the steps
above for creating an email message template.

MBS Billing to Medicare - Accounts

In terms of billing Medicare for the consultation, billing is done with two item numbers, the usual
item number for a new consult or review consult PLUS a telehealth number, for instance;

Paediatrics: 112 (telehealth number) + 116 (review item number)
Endocrinology: 112 (telehealth number) + 116 (review item number)
Palliative Care: 3015 (telehealth number) + 3010 (review item number)

*All rules regarding referrals are valid for telehealth consultations as they are for face to face
consultations.

Telehealth: Resource Package
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3. How to use Cisco Meeting Server (CMS)

This document outlines the user case workflow for the virtual outpatient use case as demonstrated
by Cisco System using the Cisco Meeting Server, the Cisco Meeting App and Cisco Telepresence
conferencing systems.

The outpatient consultation is a permanent space created on the Cisco Meeting Server. The space is
administrated by a Bendigo Health administrator using the Cisco Meeting App. Patients join the
space from a PC or Mac using a standard web browser or from a mobile device using the Cisco
meeting App.

The LMRHA Virtual Outpatient Use Case Workflow is accessible on Bendigo Health’s intranet page.
The Loddon Mallee Rural Health Alliance can be contacted on (03) 5434 1000 for further
information.

Telehealth: Resource Package
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4. Process Map Example - Telehealth Specialist Clinics

Telehealth Clinic

= Doctar/Clinician

© identifies patient

= suitable for

o Telehealth

- i - Hand patient the

g B““'T‘mma Telehealth Set up the room for Patient welcomed

(& N appointment letter the telehealth by Ward Clerk and Arrives patient in . .

T i "‘"‘_"“‘"‘“ﬂ‘;d ™1 ormaiks out letter session (includes - PAS R
o ) and information COW/surface pro} information

g pack A

= Dials into Health Patient placed on
[} Direct virtual hold until Clinician
% waiting area via BH is ready for the
- % website appointment
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Clinician to Patient (Clinical) Resource Package

Resource | Title Description Page
Number Number
#1 Checklist for Clinician to A practical checklist developed for clinicians 18-19
Patient Consultations undertaking Telehealth consultations. Outlines
appropriate pathway of care.
#2 Telehealth Readiness These tools, developed by the University of 20-25
Assessment Tools Calgary provide a guide to identify any barriers
or risks prior to implementation of telehealth
services.
#3 Patient Information Sheet on | An example of information sheet you can 26
participating in a Telehealth | provide to patients and their carers.
consultation
#4 Telehealth Consultation Example of written consent form for Telehealth 27
Consent consultation (optional).
#5 Telehealth Template for A template for documentation of Telehealth 28
Documentation of consultation
Consultation
#6 Patient Evaluation Survey Some examples for patient evaluation of 29-30

Questions & Evaluation
Considerations

telehealth service

*ACl Guidelines for the use of Telehealth for Clinical and Non Clinical Settings in NSW

Telehealth: Resource Package
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Resource #1 — Checklist for Clinician to Patient Consultations

This checklist has been designed to offer the practical steps/prompts required to conduct successful
telehealth sessions, for clinicians who are planning to undertake telehealth consultations with the

patient/carers.

Stage

Pathway

Prior to the consultation

1.

Ensure Telehealth Readiness Assessment tools have been
completed (refer to Resource #2 for example)

2. Consider the appropriateness for the consultation to be held via
telehealth or by face to face

3. Ensure all patient information results have been sent to the clinician
providing the consult in advance

4. Depending on your local health device, please consider secure
messaging software — you can discuss this with your local Telehealth
Manager or IT Manager (for sending information about patients)

5. Identify a contact at the far site where the patient will be and
consider if a staff member is required to be with the patient during
the consult

6. Identify if patient has a carer who should be included in all
correspondence about the upcoming telehealth session

7. Receiver-end: provide patient and his/her carer
information/brochure on telehealth

8. Confirm appointment with patient or his/her carer

9. ltisideal to build some rapport with the patient and his/her carer (if
applicable) prior to the telehealth consultation to make team more
comfortable (e.g. a phone call prior)

Day of the consultation 10. Test the equipment 15-30 minutes prior

11. Ensure positioning of the camera and remember to look at the
camera when talking. It is ideal to have the camera above the
screen so when you look at the screen the camera is directed at
your face (e.g. rather than your side)

12. Ensure all documentation has been received

Time of the consultation 13. Put mobile phone to silent

14. Be aware there is a slight delay in using videoconferencing — when
asking questions wait until the party has stopped speaking and then
respond

15. |If applicable in the multi-site telehealth consults — please ensure
your site is on ‘mute’ if you are not talking

16. Provide an overview on how the technology works and how the

session will run

Telehealth: Resource Package
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Time of the consultation
(continued)

17.
18.
19.

20.

21.
22.

23.
24.
25.

Speak naturally

Introduce yourself and other people in both rooms and their roles
All clinicians at all sites have agreed to participate in the
consultation and document where possible any additional staff who
enter the room during the consultation — document names in the
telehealth documentation template

Receive verbal consent from patient and his/her carer to continue
with the consult and document in notes (refer to Resource #4 for
example)

Confirm Medicare bulk billing (if applicable)

Inform the patient and his/her carer that this session is private; is a
confidential secure link and it will NOT be recorded

Record notes to the consult at both ends (refer to template)
Discuss next steps and follow up appointment (if required)

Ensure the patient, his/her carer and other staff involved in the
consultation are clear on the next steps and don’t have any other
questions

After the consultation

26.

27.

28.

29.
30.

Ask staff / and or patients and their carers to complete a survey
based on their experience (if appropriate)

Enter the Occasion of Service for Activity Based Funding if applicable
— submit to Medicare if applicable

Send any scripts/medication to receiver end (if applicable) or local
pharmacy

Enter patient notes in their medical record

Organise follow up (if applicable)

*ACl Guidelines for the use of Telehealth for Clinical and Non Clinical Settings in NSW

Telehealth: Resource Package
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Resource #2 — Telehealth Readiness Assessment Tools

Using the five-point scale rate YOUR ORGANISATION on the following statements:

1 =Strongly Agree | 2 = Disagree | 3 =Neutral | 4 =Agree | 5=Strongly Agree | 0=Don’tK

A. ORGANISATIONAL CORE READINESS

now

Your Organisation

Score

Is aware of, and able to clearly articulate needs

Expresses and feels dissatisfaction with the ways it currently has available to deliver care
(e.g. status quo)

Other (please explain)

(A) Sub-total

B. ORGANISATIONAL ENGAGEMENT & PLANNING READINESS

Your Organisation

Score

Has organisational buy-in for telehealth

Has individuals who are champions for telehealth (clinical/provider, senior administration,
community champions)

Has leadership who are risk-takers and pioneers for reaching novel innovations

Is aware of organisational dynamics between innovators and resistors

Has the commitment and support of senior administration

Has access to sufficient ongoing funding from local, provincial and federal institutions

Has established collaborative partnerships

Has in place methods for telehealth communication/profiling/awareness, and is actively
involved in promoting these

Has examples and evidence of telehealth applications in similar
contexts/environments/communities

Exhibits healthy inter-organisational dynamics in telehealth promotion activities

Is willing to consider short-medium and long term timelines for implementation

Has established mechanisms of knowledge transfer among staff members

Participates in a community consultation process

Conducts ongoing needs assessments and analysis

Has a strategic business plan, including:
e A marketing, communication, and evaluation plan
e A cost benefit and cost effectiveness assessment, including benefits and risks
e Financial readiness for sustainability

Other (please explain)

(B) Sub-total

Telehealth: Resource Package
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C. ORGANISATIONAL WORKPLACE READINESS (Administrative, Human and Physical

Structures)

Your Organisation

Score

Ensures the workplaces are prepared for telehealth technology and equipment:
e Establishes proper facilities (e.g. location, lighting, size and other equipment)

e Located telehealth equipment where it is convenient for providers to use as a tool

to deliver patient care

e Facilities the creative use of equipment by practitioners and patients

e Provides administrative support for clinical decisions, functioning and the process
of using the telehealth system

e Has astandardised, well defined easy to use referral system

e Has a standard and consistent method of record keeping at both the receiving and

referring site

Recognises and addressed policies and procedures/professional and regulatory barriers:

e Ascertains that telehealth practices conform to health protection laws

e Ascertains that telehealth practices conform to professional regulatory policies

e Reviews existing policies, standards and procedures to determine if telehealth is
covered under them, if not, revises as appropriate

e Formulates and integrates written policies on reimbursement, liability, cross-
jurisdiction use and privacy issues

e Prepares related written procedure manuals

e Formulates policies for defining who gets privileges to use telehealth at the
receiving and referring sites

Establishes open lines of communication:
e Manages open communication, keeping all stakeholders well informed
e Participates in communication to facilitate team building
e Liaises with practitioners, patients and the public as important players in the
successful implementation of telehealth

Addresses change management readiness:
e Has a change management plan in place to deal with organisational input
e Has effective scheduling and integration of innovators into established practices

Addresses human resources readiness:
e Has adequate and dedicated human resources to implement the strategic plan
e Employs a local telehealth coordinator
e Determines classification of roles and responsibilities in relation to specific
telehealth application(s)

Telehealth: Resource Package
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Your Organisation Score

Addresses training and continuing professional development (CPD) readiness:
e Prepares staff and all end-users for initial and ongoing training
e Has a training and CPD plan in place related to telehealth

e Has part telehealth experience gained from projects or pilot programs and their
evaluation

Other (please explain)

(C) Sub-total

D. ORGANISATIONAL TECHNICAL READINESS

Your Organisation Score

Has addressed the technical feasibility and technical requirement issues

Has established interoperability of equipment and technology

Has a consistent approach to verification of the fidelity of data transmission

Has validated that the technology actually works

Has access to comprehensive technical support that is available locally

Other (please explain)

(D) Sub-total

Total Score: A+B+C=+D =

SCORING

130 + The organisation is in a good position to implement telehealth successfully
86—-129 Certain items may adversely impact successful telehealth implementation

0-85 There are barriers to successful implementation that need to be addressed before

moving forward in implementation

*ACl Guidelines for the use of Telehealth for Clinical and Non Clinical Settings in NSW
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Resource #2 — Patient/Public Telehealth Readiness Assessment Tool

Using the five-point scale rate YOUR RESPONSES on the following statements:

1 =Strongly Agree | 2 =Disagree | 3 =Neutral | 4=Agree | 5=Strongly Agree | 0=Don’t Know

A. ORGANISATIONAL CORE READINESS

A: As a Patient/Public, in order to meet the requirements for CORE READINESS, I:

Score

Identify with a sense of isolation and a lack of access to healthcare

Identify with a sense of dissatisfaction with the current state of health care

Feel dissatisfied with usual doctor-patient interaction or have a desire for a more
comfortable setting for obtaining health information

Acknowledge unmet healthcare needs

Have a desire for change and want to actively be involved in my health and health care
condition

Other (please explain)

(A) Sub-total

B: As a Patient/Public, in order to meet the requirements for ENGAGEMENT READINESS, I:

Score

Am knowledgeable about telehealth and/or want to know what telehealth is

Acknowledge the benefits or anticipated benefits/risks

Am comfortable with using telehealth equipment

Believe that concerns specific to privacy/confidentiality/security have been addressed when
using telehealth

Believe that cultural issues can be addressed when using telehealth

Am comfortable that telehealth is an adjunct to usual care, rather than a replacement

Have a sense of ownership regarding my wellbeing and that of my community

Other (please explain)

(B) Sub-total

Total Score: A+B =

SCORING

Above 70 Patients are in a good position to use telehealth.
Between 51 — 69 Certain items may adversely impact the use of telehealth
Below 50 There are barriers to successful patient use of telehealth

*ACl Guidelines for the use of Telehealth for Clinical and Non Clinical Settings
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Resource #2 — Practitioner Telehealth Readiness Assessment Tool

Using the five-point scale rate YOUR RESPONSES on the following statements:

1 =Strongly Agree | 2 =Disagree | 3 =Neutral | 4=Agree | 5=Strongly Agree | 0=Don’t Know

A: As a Practitioner, in order to meet the requirements for CORE READINESS, | have:

Score

A feeling of dissatisfaction with the current available ways of delivering care, e.g. status
quo)

Firsthand experience of the negative effects of isolation from healthcare services
(professional and educational)

A driving need to address a public or patient healthcare problem (as opposed to a
practitioner specific one) that could be met by telehealth

Other (please explain)

(A) Sub-total

B: As a Practitioner, in order to meet the requirements for ENGAGEMENT READINESS, I:

Score

Am an innovator and/or champion for telehealth

Have a sense of curiosity about the influences of telehealth on improving the delivery of
healthcare (potential benefits)

Have respect for others in the telehealth team

Have the need to interact with other practitioners

Have examples and evidence of telehealth applications in similar contexts, environments
and communities

Communicate with other practitioners / public concerning the benefits about telehealth

Am willing to make the initial extra investment in time

Other (please explain)

(B) Sub-total

C: As a Practitioner, in order to meet the requirements for STRUCTURAL READINESS, I:

Score

Believe telehealth can address scheduling concerns and apprehensions about overextended
workloads

Have 24 hours access to telehealth equipment

Have telehealth reimbursement plans in place

Have dealt with apprehensions about the reliability in telehealth equipment and have good
technical support and backup plans

Have access to an established reliable and available clinical consultation network (human)
when using telehealth

Am provided with reliable clinical content and continuing medical education (CME) through
telehealth

Attend to issues regarding liability and licensing when using telehealth

Other (please explain)

(C) Sub-total
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Total Score: A+B+C =

SCORING

Above 80 Practitioners are in a good position to use telehealth.
Between 61 — 79 Certain items may adversely impact the use of telehealth
Below 60 There are barriers to successful practitioner use of telehealth

*ACI Guidelines for the use of Telehealth for Clinical and Non Clinical Settings in NSW
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Resource #3 — Patient Information Sheet on participating in a Telehealth consultation

What is a Telehealth consultation?

Telehealth is a normal medical consultation between a patient and a medical specialist using video
conferencing software and an audio and visual link over the internet, without having to attend the
appointment at the hospital (face to face).

Why use Telehealth?
A Telehealth consultation reduces the need for you to travel to large towns or cities to receive your
treatment.

How will | see my specialist if we are not in the same room?

The most common piece of technology used to deliver telehealth consultations is videoconferencing.
It is similar to a normal telephone call, with the added benefit of being able to see the participants at
the other end. Most video conferencing equipment allows you to transmit data, e.g. presentations,
photographs, x-rays and video.

Who will be part of the consultation?

At the time of the consultation you will see your treating clinician through a screen. There may be a
staff member with you in the room if it is deemed appropriate and you are comfortable with that
(for example, if they have to check your blood pressure or read through results). You can choose if a
family member, your carer or other support person attends the appointment with you.

Consent for the consultation?

Verbal consent is required at the beginning of the consultation before consultation will proceed and
all staff part of the consultation will be introduced at the beginning of the session. The three
identifiers include (full name, date of birth and address).

Your follow up appointment?
A follow up appointment will be made if required.

How much will the consultation cost?
There should be no additional cost to you other than your usual consultation fees.

What if | don’t want to be part of a Telehealth consultation?
You may choose not to participate in a telehealth consultation if you are uncomfortable. Or, if you
are uncomfortable during the session, you can ask to finish the consultation.

Maintaining your privacy and confidentiality?

All consultations done via telehealth are private and secure and WILL NOT be recorded.
Documentation will be taken during the consultation by the clinicians at both ends (if there are
clinicians at both ends) and will then be entered into your medical record, as would normally happen
if you saw your specialist face to face.

Bendigo Health Specialist Clinics — Brochure

As part of the Department of Health and Human Services funded Telehealth Specialist Clinic Project,
a sample brochure can be found on the Bendigo Health website to provide further information.
Bendigo Health brochure

Telehealth: Resource Package
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Resource #4 — Telehealth Consultation Consent

Telehealth Consultation Consent Affix ID Label Here

This procedure for conducting the telehealth consultation has been fully explained to me and |
understand that:

e My participation is completely voluntary and | have the right to refuse to participate

e | have the right to withdraw my consent and terminate the consultation at any time

e Health professionals are permitted to take notes during the consultation

e | agree to my medical information being used for case conference, ensuring that my right to
confidentiality is maintained.

My consent relates to (Please tick appropriate response)

e Asingle telehealth session
e An episode of care involving several telehealth sessions
e The use of medical information for a case conference

For patient over 16 years

Parent Name: (Print)

Signature of Patient:

Date:

For patient under 16 years / in Care / with Guardian

Parent / Carer / Guardian Name: (Print)

Signature of Patient / Carer / Guardian:

Date:

*ACI Guidelines for the use of Telehealth for Clinical and Non Clinical Settings in NSW

Telehealth: Resource Package
Page 24 of 28




BENDIGO HEALTHY COMMUNITIES AND

HEALTH WORLD CLASS HEALTHCARE

CARING | PASSIONATE | TRUSTWORTHY

Resource #5 — Telehealth Template for Documentation of Consultation

Telehealth Template for Affix ID Label Here
Documentation of Consultation

Date of consultation: Time:

INTRODUCTION

1. Introduce self (full name, date of birth and address)
2. Confirm patient details on ID label (if no label, please complete the ID fields above)

Staff present for consultation (at both sites) — include both their name and location

1.

*All staff listed above have agreed to be part of this consultation

Carer or other support person present with patient? Yes No

Verbal consent sought from patient to conduct consultation via telehealth please circle Yes No

SITUATION:

Problem/s and symptoms

BACKGROUND:

Allergies and adverse reactions

ASSESSMENT:

Assessment and clinical findings

RECOMMENDATION:

Outcomes, recommended actions

Next scheduled appointment:

Form completed by: Date:

*ACI Guidelines for the use of Telehealth for Clinical and Non Clinical Settings in NSW
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Resource #6 — Patient Evaluation Survey Questions

Below are some example questions that can be tailored to your service to assess the patient
satisfaction of utilising a telehealth service

Question Strongly Disagree | Neutral Agree Strongly
Agree Agree

The telehealth consultation was

convenient for me? D D D D |:|

The telehealth consultation saved

me time and money? [ [l [ [] ]

The telehealth service | received was

as good as previous face to face [ [ [ [ []

appointments?

| was comfortable talking to the

clinician/s using a computer? [ [ [ [ [

My safety and privacy were
maintained during the consultation? [ [ [ [ [

| would be happy to have more

consultations using telehealth? [ [ [ [ [

| would prefer a face to face

consultation with my clinician? [ [ [ [ []

What would you change to improve
the telehealth service?

What were the benefits of the
telehealth service?

*ACl Guidelines for the use of Telehealth for Clinical and Non Clinical Settings in NSW
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Resource #6 — Evaluation Considerations
Other areas to consider when evaluating telehealth services include:

e User acceptability (patient and clinicians)

e The persons and practitioners experience (survey)

e Satisfaction with the process or service

e Reviews of any complications

e Morbidity

e Poor outcomes for the person

e Percentage of eligible encounters performed by telehealth (rural/regional)

e Total number of kilometres travelled by patients (includes travel costs and time for outreach
clinician and/or patient)

e Total number/percentage — increase/decrease in the did not attend rates

e Diagnosis accuracy

e Validation of diagnosis

e Appropriateness of service delivered

e Information provided

e Referrals made

o The persons safety

*ACl Guidelines for the use of Telehealth for Clinical and Non Clinical Settings in NSW
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